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I Canadian Radio Interference Regulations
This digital apparatus does not exceed the Class B limits for radio noise emissions from a digital
apparatus as set out in the interference-causing equipment standard entitled “Digital Apparatus”,
ICES-003 of the Industry Canada.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils
numériques de Classe B prescrites dans la norme sur la matériel brouilleur: “Appareils Numérique:
NMB-003 édicatée par I'Industrie Canada.

I nternational Energy Star® Program
As anENERGY STAR Partner, Canon Inc. has determined that this product medtNBRGY
STAR guidelines for efficiency.

The InternationaENERGY STAR Office Equipment Program is a global program
/\ that promotes energy saving through the use of computer and other office equip-
W ment. The program backs the development and dissemination of products with

functions that effectively reduce energy consumption. It is an open system in

which business can participate voluntarily. The targeted products are office equip-

ment such as computers, monitors, printers, faxes and copiers.

Their standards and logos are uniform among participating nations.

I Fo\vcr Requirements

Never use a power supply voltage other than that supplied in the country of purchase. Using the
incorrect voltage could cause a fire or electric shock. The correct power supply voltages and fre-
quencies are as follows:

Europe AC 230V+10%, 50Hz

USA/Canada  AC 120V, 60Hz
Australia AC 240V, 50Hz



Preface

mm Shipping Materials weeesssssEEEEEEEEEEEEEEEEEEE

Thank you for purchasing a Canon Bubble Jet Printer.
Check that all the following items are in the box. If anything is missing or is damaged, contact
your Canon Authorised Dealer or Sales Representative.

0 Printer

[0 Setup Software & User’s Guide CD-ROM
[ Quick Start Guide

0 Print Head

[0 4 Ink Tanks

* Cables should be purchased separately according to your computer. For details on cable

types and specifications, refer to page 2.

mm Introduction =eesssssssssssssssssssEsEEEEEEEEEEEEE

This Quick Start Guide uses the following symbols to indicate important information. Always
observe the instructions indicated by these symbols.

Instructions that, if ignored, could result in death or serious personal injury caused by
incorrect operation of the equipment. These must be observed for safe operation.

Instructions that, if ignored, could result in personal injury or material damage caused by
incorrect operation of the equipment. These must be observed for safe operation.

Also read the Safety Precautions in the User’s Guide. Observe the warnings and cautions to
avoid personal injury or damage to the printer.

P
Trademark Notices

* Canon® is a registered trademark of Canon Inc.

e BJ™ js a trademark of Canon Inc.

* Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft
Corporation in the U.S. and other countries.

* Apple, Mac and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S.
and other countries.

¢ All other trademarks and registered trademarks appearing in this Quick Start Guide are
the property of their respective owners.

Copyright ©2002 CANON INC.
All rights reserved. No part of this publication may be transmitted or copied in any form
whatsoever without the express written permission.




Setting Up

mm 1m Preparing the Printer messsssssssssssssssssmmmmms
1 Place the printer on a flat surface.

2 Remove the packing material and tape
from the printer as shown.

3 Attach the paper rest to the sheet
feeder.
paper rest

output tray 4 Attach the output tray as shown.

mm 2m Connecting the Printer to the Computer wmememmm——

Use either a USB cable or parallel printer cable. You cannot connect the computer to the printer
using both the parallel cable AND the USB cable.

USB cable Printer cable (parallel)
¢ Windows XP, Windows Me, ¢ Windows NT 4.0, Windows 95
Windows 2000, Windows 98, (Can also be used with Windows XP,
® Mac OS 8.6 or later Windows Me, Windows 2000 and
Windows 98.)

Recommended: Canon or other computer Should conform with Centronics IEEE 1284

manufacturer cable, up to 5 meters in length. and support bi-directional communication.
Recommended: Canon or other computer
manufacturer cable, up to 2 meters in length.



[l Notes

® The USB cable delivers relatively faster printing speeds and is recommended for use
with Windows XP, Windows Me, Windows 2000 and Windows 98.

e If your computer has an earth connection, make sure that this is attached.

¢ If you do not intend to use the printer for a long period of time, unplug the power cord
from the power outlet after turning off the printer.

Follow the steps below to install the printer
driver correctly.

1 Ensure the printer and the computer
are switched off.

Figure A 2 Connect the cable.

Figure A shows the USB cable connection and
Figure B shows the printer cable (parallel)
connection.

] Note

If the Add New Hardware Wizard or Found New Hardware
Wizard screen appears when carrying out the following
operations, click Cancel and turn off the computer.

Windows has found the following new harduare:

5520

Windows c:

What would you like to do?
(® {aiitamatic search for 3 better diiver [Hecommended}

 Speciy the lncation of the diver [Advanced)

Bk Corce




mm 3m Installing the Print Head wessesssssssssssssssssnn

* Never attempt to plug the power cord into the power outlet or unplug the power cord
when your hands are wet.

* Never damage, modify, stretch, or excessively bend or twist the power cord. Do not place
heavy objects on the power cord.

* Never use any power supply other than the standard power supply available in the
country of purchase. Using the incorrect voltage and frequency could cause a fire or
electric shock.

¢ Always push the plug all the way into the power outlet.

m Installing the Print Head

1 Plug the printer in.
2 Turn on the printer. Do NOT turn on
the computer yet.

The POWER lamp flashes and the printer begins
to operate. Wait until the POWER lamp remains
fully lit.

3 Open the front cover.

4 Remove the tape.

5 Raise the lock lever.

Do not touch internal parts other than the lock
lever.




6 Remove the protective cap from the

print head.

U Notes electrical contacts

® Do not touch the print head
print head nozzles or nozzles

electrical contacts.

* Do not attempt to
reattach the
protective cap once it
has been removed.

7 Place the print head in the holder.

m

L&,

Gt
Ly

print head
holder

8 Lock the print head into place by
lowering the lever.

Do not touch the lock lever once the print head
has been installed.

m Installing the Ink Tanks

A\ Caution

e For safety reasons, store ink tanks out of the reach of small children.
* Do not drop or shake ink tanks.

1 Take out the yellow ink tank.

r 2 Pull the orange tape in the direction of
the arrow and remove the clear film.



3 Hold the ink tank as shown in the

\ diagram and remove the protective
&
cap.
[1 Notes
¢ Do not squeeze the sides  ink port

of the ink tanks as this
may cause the ink to leak ©%
out and stain your clothes & H
and hands.
¢ Do not touch the ink port.
* Do not attempt to reattach
the protective cap once it
has been removed.

)

4 Insert the yellow ink tank into the right-
hand slot. Press the top until it clicks
into place.

5 Use the same procedure to install the
other ink tanks in their appropriate
slots.

Check the labels to make sure that each tank is in
the correct position.

[] Notes

¢ Only install the ink tanks in the positions
specified by the labels.

e If ink tanks are not installed in the right
position, colours will not be printed
correctly. Immediately reinstall the tank in
the correct position and carry out print head

Magenta cleaning. For details, refer to the User’s

Yellow Guide.

6 Close the front cover.

Wait until the POWER lamp remains fully lit
(about 60 seconds).



um 4u Loading Paper messssssseesss eSS

m Loading A4 (Letter) Size Plain Paper

paper thickness lever

1

Open the front cover.

Move the paper thickness lever at the
top of the print head holder to the left
position. Close the front cover.

[1 Note

Set the paper thickness lever to the left when
using plain paper, to the right when using
thick paper. Refer to the User’s Guide for
information on loading envelopes and other
media.

Load the paper, aligning it with the
right side of the sheet feeder.

You can load up to 100 sheets of plain paper. Do
not exceed this limit.

Press the paper guide and slide it
against the left side of the stack of
paper.

You now need to install the printer driver:
Windows: Go to page 8
Macintosh: ~ Go to page 10




mm 5m Installing the Printer Driver messeesssssssssssnnnnn

m [nstalling the Printer Driver - Windows

[] Notes

* Do not disconnect the cable or remove the CD-ROM during the installation. The driver
cannot be correctly installed.

® The screens below refer to Windows Me installation. Screen may differ depending on
the environment you are using.

® When installing the printer driver in Windows XP, Windows 2000 or Windows NT 4.0,
log on to the system as a member of the Administrators group.

If the following screen appears automatically, click Cancel and follow steps 1 to 7 to install
the driver.

ble 10 locate the software for this

1f you da nat wank ta install the saltware naw, click Finish.

To search again, click Back.

What would you ke to do?

& Bio

1 for a beiter diver (Hecommendedt

" Speciy the lacation of the difver {advanced)

CEak = Bk B

Special Notes for Windows 98 or Windows Me USB Users

Click Cancel to quit the screen and turn off the printer. Next, remove and replace the USB
cable connected to your computer.

1 Ensure the printer and computer are
switched off.

2 Turn on the computer and start
Windows. If any applications
automatically run, quit them.

Disable any virus detection programs.
Do NOT turn the printer on at this stage.




Documentation

Terminate Installation

Software installation is completed
Irestallation results are as follovs,

Prirtter Driver Inztalled

3 Place the Setup Software & User’s
Guide CD-ROM in the CD-ROM drive.

[1 Notes

o If the CD-ROM does not run automatically,
double-click My Computer in the Windows
screen, then double-click the CD-ROM icon.

o If the language selection screen appears,
select a language, then click the Next button.

4 Follow the instructions displayed on
screen. When the screen shown on the
left is displayed, click Install .

5 When the screen shown on the left
appears, turn the printer on.

If the printer is recognised, the printer driver will
be automatically installed.

I Note

If the connection is not recognised, refer to the
section “Notes on Handling the USB Interface
(for Windows Users)” on page 21.

6 Click OK.

Before you can use the printer, you must carry out
print head alignment on page 12.



Canon Clck the buton o s

View Documents.

Printer Driver

When the screen shown on the left
appears, click Exit.

[] Note

¢ To view the User’s Guide, please refer to
page 21.

¢ If a message prompting you to restart the
computer appears, click Yes.

m Installing the Printer Driver - Macintosh

[1 Notes

* Do not remove or insert the USB cable during installation, as this may result in the
computer or printer not operating correctly.

* Before installing the driver, disable all virus detection programs and automatically
loading programs or remove them from your system folder.

] [El cANONBI————H15
a Fitems, 961 K available
Acrobat Reader4.0 Manual =1
[ ]7Z
0 =—=—=[E] (ANON_BI=F= =|
] 2 items, 1 MB available

@ E=E
Installer Read Me

S ]

[4]»

ICANON SOFTWARE LICENSE AGREEMENT

uuuuuuuuu -READ THIS AGREEMENT BEFORE INSTALLING THE PRINTER DRIVER FOR BUBBLE-JET

IPRINTER. BY INSTALLING THE PRINTER DRIVER FOR BUBBLE.JET PRITER, YOU ARE DEEVED T0

[AGREE TO BE BOUND BY THIS AGREEMENT.

AINED IT FOR A REFUND BEFORE THEY ARE USED.

© the SOFTWARE, you agree to abide by the terms and

10

1
2

Turn on the Mac.

Place the Setup Software & User’s
Guide CD-ROM in the CD-ROM drive.

Double-click the printer driver folder,
then select a language.

Double-click Installer .

Read the Licence Agreement and click
Accept to continue.



Easy Install +

Click "Install” to install the following software: After the installation is
completed, restart the computer.

#5520 QuickDraw printer driver

#5520 printer utilities

#8520 printer profile

~ Install Location

e il be ngtalled on the disk Macintazh_UC

 F—

Installation was successful. You have installed
software which requires you to restartyour
computer. Ifyou are finished, click Restart, or ifyou
wish to perform additional installations, click

Continue.

nFile Edit View Special Help
About This Computer

&D Apple System Profiler
3

Chooser

(i, Favorites »
Key Caps

Network Browser

[, Recent Applications b
[l RecentDocuments  »

Ef Rerant Sarvarc b

O———————hooser ———§|
Connected to :
5520 1

Backgrounding
Gon @on

3 Active
AppleTalk
® Inactive 7.6.2

6 Click Install .

Wait for the installation to finish.

[] Note

No other applications can be running during

@ this installation. Click Continue to
automatically quit all other running
applications. Click Cancel to leave your
disks untouched.

(ontne ]

If the above message appears, check that there
are no unsaved documents, then click the
Continue button. If a document needs to be
saved, click Cancel then save the document.
After saving the document, begin again from
Step 4.

7 Click Restart.

The computer restarts.

8 Select Chooser in the Apple Menu.

9 Click the icon for the printer you are
using and close Chooser .

Before you use the printer, you must carry out
print head alignment on page 14.

[1 Note

Refer to the User’s Guide when using this
printer as a network printer.

11



mm 6u Aligning the Print Head wessssssssssssssssssssmn

This operation must be carried out when using the printer for the first time. Aligning the
print head positions allows you to print without shifts in the colour registration.

m Aligning the Print Head - Windows

|[ Bl Edt View Favoites Toos Help

Open B seorch [y Folders & AHitmy | [ (2

Pause Priniing
v Selas Default

Puigs Print Documents

Sharing. Add Printer  Canon LASER - {BEMEET
SHOT LEP-

= =TT

|- Capture Frinter Port —
End Caplure

Create Shortcut
Delste

Canon 5520 |

This printer requites print head alignment
Click [Print Head Alignment] in Maintenance to start alignment,

Gond | Do | | shava || s . |
© Soacigond | ot Hec | P

@ sttt
o | ot | i |t

Click Start and select Printers in
Settings .

[] Note

For Windows XP, click Start and select
Control Panel, Printers and Other Hardware,
and then Printers and Faxes.

12

Click the icon for your printer.

Open the File menu and select:

¢ Windows Me/Windows 98/
Windows 95 - [Properties]

* Windows XP/Windows 2000 - [Printing
Preferences...]

e Windows NT 4.0 - [Document Defaults...]

to open the setting screen.

Click OK.

Click the Maintenance tab, and click
the Print Head Alignment icon.

Check that paper is loaded in the

printer and click OK. If a message
warning you not to perform other

operations appeatrs, click OK.



Print Head Alignment

& I3 the pattern printed successfull?

IF nothing is printed, or if the patter is significantly faint and scratchy.
select [No] and iy again.

Print Head Alignment
Print head alignment is being executed. Riefering to the patiems printed in
columne & to F. select the pattein that shaws na faws

Harizorntal Alignment (-3 o +7)

Biditectional Alignment -5 to +5]

-

=

£ s (L3
E] Column B a

H Colurn G =

Column D ==

Column E ==

Column E ==
Print Head Alignment 2=

Print head alignment is being executed. Referring to the pattems printed in
columns & to F, select the patten that shows no faws.

Harizontal Alignment [-3 to +7

- 1
=
E Cohumns =
=
E] Calumn B =
= Column O=|
Bidiectional Alignment [-5 ] +5)
Column D =
Column £ =}
Colurn £ O=!
\_ J
[il3 | Help
Print Head Alignment

@ Frint head alignment iz how complate.

7 After the pattern is printed, click Yes.

If the pattern is not printed successfully, open the

front cover and ensure that the ink tanks are
correctly installed.

8 Look at the print-out. From the patterns

in Column A, select the most even,
least irregular pattern and enter the
number.

9 In the same way, one by one, select

the most even patterns printed with the

least irregularities from each of
Columns B to F, enter their numbers,
and click OK.

If it is difficult to pick the best pattern on Column

E pick the setting that produces the least
noticeable vertical white stripes.

Less noticeable
white stripes

More noticeable
white stripes

10 Click OK.

This completes the printer setup. The printer is
now ready to use.

13



m Aligning the Print Head - Macintosh

Canon 5520

Version 39

200 | orientation:

scale: %[z

[ save Settings

Canon s520Printer Utility

Print head alignment is being executed.
Alignment entails printing, so do the
following: Ready the printer (connect the

cable and

printer's paper thickness lever to the left,
and load a sheet of plain paper in the sheet
feeder. Do you want to print head alignment

patterns?

turn the power on), move the

b

Print Head Alignment

Print haad alignment is bei

printed in columns A to F, select the pattern that shows no flaws.

ing executed. Referring to the patterns

E Column A :
E Column B: =13
é Column C:
= Adjust both ways(-5~+5)
Column D :
Column E:
Column F:

Adjust sideways(-3~+7)

14

Select Page Setup in the File Menu.
Click Utilities .

Select Test Print from the menu and
click the Print Head Alignment icon.

Check that paper is loaded in the
printer and click OK.
If the pattern is not printed successfully, open the

front cover and ensure that the ink tanks are
correctly installed.

Look at the print-out. From the patterns
in Column A, select the most even,
least irregular pattern and enter the
number.



Print Head Alignment

Print head alignment is being executed. Referring to the patterns
printed in columns Ato F,select the pattern that shows no flaws.

Adjust sideways(-3~+7)
= R B
= ColumnA: !',-
: =

- Column B :
=
= Column C: 2]
B
= Adjust both ways(-5~+5)

Column D:

Column E:

Column F:

Canon $520 Printer Utility Version 3.9

TestPrint T

B Nozzle Check
Prints a nozzle-check pattern.
[ | Print Head Atignment
Itwill align the print heads to correct any

error in their installation position.

Canon 5520

scate: “@
Height :297.0mm __ Width :210.0mm Orlentation: 'M

[ save Settings.

6

In the same way, one by one, select
the most even patterns printed with the
least irregularities from each of
Columns B to F, enter their numbers
and click Send.

If it is difficult to pick the best pattern on Column

E, pick the setting that produces the least
noticeable vertical white stripes.

Less noticeable
white stripes

More noticeable
white stripes

7 Click Close.

8 Click OK.

This completes the printer setup. The printer is
now ready to use.

15



Basic Operations

e If you detect smoke, unusual smells or strange noises around the printer, immediately
switch the printer off and always unplug the printer. Contact your local Canon service

representive.
¢ To avoid injury, never put your hand or fingers inside the printer while it is printing.

mm Printing with Windows messssssssssssssssssEE——

Adjusting the print settings according to your needs allows you to produce better quality prints.
In this section, we will use WordPad for the purpose of explanation. The procedures you use
and the screens that appear on your computer may differ according to the application that you

use.

m Printing
% Edit Wiew Insett Fomat Help 1 Print the document from the
Hew... Ctrl+N 3 H H
o 11 0 A =) =l S = application.
ou e L Hjo = On the File menu, click Print.
— R Check the application’s users manual for the
BT actual procedures.
Page Se;gp. .
I 1l 2 Ensure your printer is selected, then

click Properties .

Name: Propeties..

Stalus:  Default printer; Fleax
Typs:  Canon 5520
Where:  USBPANDT

Comment I Pinttofie
~Piink rang s

& Al Number of copies: |1 3:
€ Pages from: 1 to: - I e
C e

3 Specify the required settings and click
OK.

[] Note

If you use anything other than plain paper,
please refer to “Basic Print Settings” on
page 17.

st | oot
(=)o | e

4 To start printing, click OK.

Printing will start in a few moments.

16



m Basic Print Settings

For the best print quality, specify the minimum requirement settings in the Main tab. To get
the best results, ensure you select the type of media loaded in the printer when printing on

paper other than plain paper.

Canon 5520 Properties

@—0

Main | Page Satup | Stamp/Backaround | Effects | Frofles | Maintenance |
Media Type: (I Plain Paper j) (1)
Baper Source: |4wto Sheet Feeder =]
Print Quality:  High )
: & Standard
& |cn @
----- " Draft
 Cust Set
Custam 1)
Colour Adiustment: (& futa A 3
' Manual St ) ( )
A4
Mormal-size Printing ™ Greyseale Printing
Starnp: None
Background:  Maone
Effects: Nane
Ahout Defatlts
1] I Cancel | Apply q Help | (4)

(1) Media Type

Select the type of media loaded in the printer.

(2) Print Quality

Select one option from High, Standard and Draft. Select Custom to
set the print quality manually.

(3) Colour Adjustment

If you wish to control the colour adjustment settings in more detail,
select Manual .

elp ick this for a more detailed explanation of the functions in the tab.

4) Hel Click this f detailed | i f the functi in the tab
(This may not appear when using Windows 2000 or Windows NT 4.0.
If this happens, click Start then select Programs - Canon S520 -
Guide).

5)? Click this to change the cursor shape to ?. By clicking on the item’s
name with this ? cursor, an explanation will be displayed.

[] Notes

¢ Clicking the Print Advisor allows you to change to the most appropriate print settings
simply by answering questions when prompted.

¢ Use the application to set the paper size and paper orientation. Before printing, open
the settings screen and check that the Page Size in the Page Setup tab is the same as
that specified within application.

e Refer to the User’s Guide for more information about printer driver functionality.

17



mm Printing with Macintosh seesssssssssssssssssms———

Adjusting the print settings according to your needs allows you to produce better quality prints.

m Printing
@ Edit Font_Size Style So 1 Open the Page Setup dialog box in
| New =S H :
| open.. %0 F——— your application.
Cose BW On the File menu, click Page Setup. Check the
:ﬂve A L application’s users manual for the actual
ave ASs..

procedures.

Page Setup.. |
Print... £
Print One Copy
Quit *#0Q

Canon 5520

2 Specify the page setup.
For details, refer to “Page Setup” on page 19.

3 Edit Font Size Style So 3 Open the Print dialog box in your

o = = application to print the document.
| Close W On the File menu, click Print. Check the

Save E application’s users manual for the actual

Save As... procedures.

Page Setup...

Print... %P ||

Print One Copy

Quit %0

4 Specify the print settings according to

copies: [1_| Pages: @1 Qfom [ |t [ ] your requlrements

BJ Cartridge PrintMode :

e pe: =
"

Plain Paper E

For details, refer to “Basic Print Settings” on
page 19.

ot

fii 8

Paper Source:
er

Apply...

5 Click the Print button.

Printing will start in a few moments.

18



m Page Setup
Use the Page Setup dialog box to specify the paper size settings.

Canon 5520 Version 3.9
0K I
Paper Size %—Select paper
(_cancel ] R .
[ Banner Printing size you wish
e [ Borderless Printing to use.
e Amount of Extension:
Min. e Max.
Scale: % @
Height:207.0mm  Width: 210.0mm orientation:  [J
[1 Save Settings

m Basic Print Settings

For the best print quality, specify the minimum requirement settings in the Print dialog box.

To get the best

results, ensure you select the type of media loaded in the printer when

printing on paper other than plain paper.

(1) —

Canomn 5520 Version 3.9
() Sl ©
Copies: EI Pages: @ All O From l:l To l:l
BJ Cartridge : Print Mode :
[cotour’ =] @
'\":_‘A'LILEC"a Type: Details...
Plain Paper 3 | ) Toment Setngs et
) — { Print Quality : Normal (Fast) Options...
Paper Source: ! Halftoning :Diffusion [—]
[Auto Feeder i] ¢ Lolowr Correction (BJ Standard Apply...
[ Greyscale Printing

(1) Media Type

Select the type of media loaded in the printer.

(2) Print Mode

Select the icon closest to the type of document you want to print.
To specify more detailed settings for the print quality or colour, select
Manual and click Details .

(3) Print

Click this to start printing.

[] Note

¢ See Balloon Help for more information about other printer driver functions.
Select Show Balloonsin the Help menu for an explanation of each of the items in the
setting screen. To see the explanation, point to the item with the mouse.

e Refer to the User’s Guide for more information about printer driver functionality.

19



Print Head Maintenance

m |f Blurring Occurs or If a Specific Colour Does Not Print

Perform print head cleaning to improve the print quality. Ensure that the printer is turned
on and follow the instructions below.

e Windows
Open the printer driver settings screen and click the Maintenance tab. Click the Cleaning icon.
See page 12 for details on how to open the setting screen.

* Macintosh
Open the Page Setup dialog box and click the Utilities button. Click the Cleaning icon.

m \When the Printer Runs out of Ink

Replace the empty ink tank with a new one.
Specify the following ink tanks when purchasing.

Yellow  BCI-3eY
Magenta BCI-3eM
Cyan  BCI-3eC
Black  BCI-3eBK

1 Open the front cover and remove the
empty ink tank.

Do not touch the lock lever.

2 Install the new ink tank.

Close the front cover when finished.

[] Note

For more details about maintenance, refer to
the User’s Guide.




Notes on Handling the USB Interface (for Windows Users)

If installation of the printer driver does not proceed as instructed in this Quick Start Guide,
there may be a problem with the USB driver installation.
Try reinstalling the printer driver.

m Reinstalling
If you cannot proceed beyond the Printer Port screen:
e - 1 Click Cancel.
O ybsn e Avertpaliion screan
. | 3 When the Terminate Installation screen
I’j" is displayed, click OK.
i 4 Turn the printer off.
== 5 Reinstall the printer driver (see page 8).

For Further Detalils...

For more information, place the Setup Software & User’s Guide CD-ROM in the CD-ROM
drive.

User’s Guide Contents

The “User’s Guide” is in PDF format and can be found on the same CD-ROM as the printer
driver. You can view this Guide on screen and print out any sections you require.

Contents

® Printer parts and their functions
e Printer driver functions

e Routine maintenance

® Printing media
e Troubleshooting
e Specifications

How to View the User's Guide

For Macintosh

(1) Load the CD-ROM in your computer.
If Acrobat Reader 3.0 or later is not
already installed, double-click the
Acrobat Reader 4.0 folder in the CD-

For Windows

(1) Load the CD-ROM in your computer.

(2) Click Documentation on the left of
the screen.

(3) Click View Documents.

If Acrobat Reader is not installed or
Acrobat Reader 4.0 is installed, a
message appears. Click Yes. Follow
the instructions on screen to install

ROM folder, then double-click
Reader 4.0 Installer. Follow the
instructions on the screen to install
Acrobat Reader.

(2) Double-click the Manual folder.

(3) Select a language folder.

(4) Double-click the icon for the
S520_UG_UK.PDF file.

the program. The User’s Guide will
appear once installation is complete.

21
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BJ Printer Driver Systems Requirements

For Windows

¢ Windows XP, Windows Me, Windows 2000, Windows 98, Windows NT 4.0, Windows 95

* USB interface or standard 25 pin parallel interface

* For the USB interface, use a computer on which Windows XP, Windows Me,

Windows 2000 or Windows 98 has been preinstalled (including computers preinstalled
with Windows Me, Windows 98 upgraded to Windows XP or Windows 2000).

* 15MB of available hard-disk space for Windows Me/Windows 98/Windows 95

* 25MB of available hard-disk space for Windows XP/Windows 2000/ Windows NT 4.0

® 16MB of available RAM for Windows 98/Windows NT 4.0/Windows 95

® 32MB of available RAM for Windows Me/Windows 2000 Professional

* 64MB of available RAM for Windows 2000 Server

¢ 128MB of available RAM for Windows XP

For Macintosh

* Macintosh series computer equipped with USB interface

* Preinstalled Mac OS 8.6 - Mac OS 9.x

* 30MB of available hard-disk space (including temporary storage space)
* 12MB of available RAM (unused block)

Additional Systems Requirements for User's Guide

To install Adobe Acrobat Reader and view the User's Guide:

* 8MB of available hard-disk space for Windows

* 13MB of available hard-disk space for Mac OS

* 640 x 480 pixels or greater, minimum 256 colours video display






® This publication uses 50% recycled paper.

® Document réalisé avec du papier recyclé a 50%.

@ Diese Publikation wurde auf zu 50% wiederverwertetem Papier ausgedruckt.
Canon ® COERIMISEIRES0% SALBEREEALTVET.

QAT7-1774-V01 12345678 ©CANON INC.2002 PRINTED IN THAILAND



